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Historial de cambios
Versión de
producto

Manual de
instrucciones

Cambios Comentarios

2.09.xx BA00065S/04/ES/01.12 – Manual de instrucciones original

2.09.xx BA00065S/04/ES/02.13 Nuevo (New) WirelessHART, tarjeta NI, módem FFusb;
módem bluetooth MACTek, instalación de
DTM, catálogo de DTM de actualización,
sustitución de iDTM

Editorial Procedimiento para USB de instalación en
Windows 7

Esquema Nuevo CD

2.10.xx BA00065S/04/ES/03.15 Esquema Nuevo CMS

Nuevo (New) HART mediante Rockwell Automation
ControlLogix, PROFIBUS PA mediante la
sección Rockwell Automation
ControlLogix, roles de usuario,
comprobación de la red

2.10.xx BA00065S/04/ES/04.15 Nuevos capítulos y
cambios

HART mediante RSG45, Fieldgate SFG500
y Siemens ET200M/iSP, PROFIBUS DP
mediante módem PROFIBUS y E/S remota
de WAGO, PROFIBUS DP mediante
PROCENTEC ProfiCore, vista de planta,
información de error SFG500

2.11.xx BA00065S/04/ES/05.16 Nuevos capítulos y
cambios

Introducción a FieldCare, E/S remota
LB/FB de Pepperl+Fuchs, HIMA, pasarela
de red (gateway) PROFINET-PROFIBUS,
PBI-PLUS, verificación Heartbeat, redes
I/O, interfase a W@M

2.11.xx BA00065S/04/ES/06.17 Documentación
separada en Manual de
instrucciones y
Documentación especial

Tutorial para proyectos FieldCare
SD01928S/04/ES

2.12.xx BA00065S/04/ES/07.17 Versión nueva del
producto
Cambios en la sección
"Operación"

-

2.13.xx BA00065S/04/ES/08.18 Versión nueva del
producto

-

2.13.xx BA00065S/04/ES/09.18 Cambios Tema IO-Link eliminado

2.14.xx BA00065S/04/ES/10.19 Versión nueva del
producto

IO-Link

2.15.xx BA00065S/04/ES/11.20 Versión nueva del
producto

Memoria USB en vez de DVD
Administración de licencias de software
(SLM)
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1  Sobre este documento

1.1  Finalidad del documento
Este Manual de instrucciones contiene toda la información necesaria para utilizar el
software: desde la descripción de producto, instalación y uso; hasta la integración del
sistema, funcionamiento, diagnóstico y localización y resolución de fallos pasando por las
actualizaciones de software y la desinstalación/borrado.

1.2  Símbolos

1.2.1  Símbolos de seguridad

Símbolo Significado

PELIGRO

¡PELIGRO!
Este símbolo le avisa de una situación peligrosa. Si no se evita dicha situación,
pueden producirse lesiones graves o mortales.

ADVERTENCIA

¡PELIGRO!
Este símbolo le avisa de una situación peligrosa. No evitar dicha situación, puede
implicar lesiones graves o incluso mortales.

ATENCI NÓ
¡ATENCIÓN!
Este símbolo le avisa de una situación peligrosa. Si no se evita dicha situación,
pueden producirse daños menores o de gravedad media.

AVISO

NOTA:
Este símbolo señala información sobre procedimientos y otros hechos importantes
que no están asociados con riesgos de lesiones.

1.2.2  Símbolos para determinados tipos de información

Símbolo Significado

Permitido
Procedimientos, procesos o acciones que están permitidos.

Preferido
Procedimientos, procesos o acciones que son preferibles.

Prohibido
Procedimientos, procesos o acciones que están prohibidos.

Consejo
Indica información adicional.

Referencia a documentación

A Referencia a páginas

Referencia a gráficos

Nota o paso individual que se debe respetar

1. , 2. , 3.… Serie de pasos

Resultado de un paso

Ayuda en caso de un problema

Inspección visual
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1.2.3  Símbolos FieldCare

Símbolo Significado

Iniciar un proyecto nuevo.

Abrir un proyecto existente.

Guardar proyecto abierto.

Imprimir proyecto abierto.

Abrir el portapapeles.

Visualizar el catálogo de DTM.

Abrir la documentación del equipo seleccionado o la información detallada del equipo.

Abrir el inventario.

Activar protocolo.

Añadir un nuevo equipo a la red.

Eliminar equipo de la red.

Crear una nueva topología de red utilizando el CommDTM y los DeviceDTM.

Compara la topología de la red en campo con la red física actual y se añaden equipos a la red
existente.

Escanea la topología preconfigurada y muestra el informe con la información del equipo escaneada.

Indica si existe una conexión establecida con el equipo.

Transferir información del equipo a FieldCare.

Transferir información de FieldCare al equipo.

Funciones específicas de equipo para el equipo seleccionado.

Añadir un nivel de planta.

Añadir un elemento.

Eliminar nivel de planta.

Eliminar elemento.

Abrir lista de comprobación de equipos para mostrar los equipos seleccionados en la planta.

Confirmar equipo sustituido.

Desconectado.  1)
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Símbolo Significado

Configurar la comunicación, listo para la comunicación.  1)

Canal de comunicación ocupado o acción de comunicación cancelada. 1)

Conectado.  1)

Símbolo W@M, aparece en la barra de inicio en la parte inferior derecha si se ha establecido la
conexión con W@M.

Activar modo táctil.

Desactivar modo táctil.

1) Indicador de estado: indicación del estado online/offline de los equipos de la planta y vista de red

1.3  Énfasis de texto

Énfasis Significado Ejemplo

Negrita Teclas, botones, iconos de programa,
pestañas, menús, comandos

Inicio → Programas → Endress+Hauser
En el menú Archivo, seleccione la opción Imprimir.

Corchetes
angulares

Variables <unidad de DVD>

1.4  Acrónimos empleados

Acrónimos Significado

CSV Valores separados por comas

DTM Gestor de tipo de equipo (drivers para los equipos)

FDT "Field Device Tool"

HART Highway Addressable Remote Transducer

E/S Entrada/Salida

IO-Link Nombre de marca de un sistema de comunicación que contiene sensores y actuadores inteligentes

IODD Descripción del equipo electrónico (descripción del equipo IO)

IP Protocolo de Internet

PROFIBUS Bus de campo para procesos

PROFINET Red de campo para procesos

SLM Administración de licencias de software

TCP Protocolo de control de transmisión

UDP Protocolo de datagramas de usuarios

URL Localizador de recursos uniforme

W@M Gestión de activos por web

1.5  Documentación
FieldCare SFE500
• Primeros pasos KA01303S/04/A2
• Tutorial para proyectos FieldCare SD01928S/04/ES
• Información técnica TI00028S/04/ES
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1.6  Marcas registradas
PROFINET® es una marca registrada de la Organización de usuarios de PROFIBUS (PNO),
Karlsruhe/Alemania.

PROFIBUS® es una marca registrada de la Organización de usuarios de PROFIBUS (PNO),
Karlsruhe/Alemania.

IO-Link® es una marca registrada del Consorcio IO-Link / Comunidad IO-Link a cargo de la
Organización de usuarios de PROFIBUS (sociedad registrada). (PNO) Karlsruhe/ Alemania

FoundationTM Fieldbus es una marca del Grupo FieldComm, Austin, TX 78759, EUA.

HART®, WirelessHART® es una marca registrada del Grupo FieldComm, Austin, TX 78759,
EUA.

EtherNet/IP es una marca registrada de ODVA, Michigan, EUA.

Modbus® es una marca registrada de Modbus Organization, Hopkinton, EUA

Todas las demás marcas y nombres de productos son marcas comerciales o marcas
comerciales registradas de las empresas y organizaciones en cuestión.



Instrucciones básicas de seguridad FieldCare SFE500

8 Endress+Hauser

2  Instrucciones básicas de seguridad

2.1  Requisitos para el personal
El acceso físico y electrónico a equipos de campo, redes, ordenadores y sistemas debe
quedar restringido a un grupo de personas autorizadas. Por lo tanto, se debe utilizar un
sistema de acceso basado en roles. Defina normativas y procesos detallados que solo
permitan el acceso al PC y al resto de equipos a personas autorizadas.

2.2  Uso correcto del equipo
FieldCare es una herramienta de gestión de activos de la planta (PAM) basada en FDT
(field device tool) que, según la versión, se puede utilizar para configurar el equipo, la
gestión de instrumentos o la monitorización del estado de los equipos. Utilizando los
gestores del tipo de equipo (DTM) adecuados, es posible operar equipos de campo y
componentes del sistema independientemente del protocolo de comunicación.

Se debe usar un cortafuegos de red (firewall) configurado correctamente para bloquear
todos los datos que no cumplan con las especificaciones de seguridad. Para una mayor
seguridad, debe desactivar todos los puertos que no estén un uso y utilizar una zona
desmilitarizada o un sistema de detección de intrusos. Para todos los productos se debe
establecer un proceso de gestión de parches organizado y puntual, p. ej., sistemas
operativos, navegadores de Internet, programas, apps, bases de datos y drivers. Asimismo,
debe instalar un antivirus en el PC. Utilice solo hardware, software, firmware y demás
contenidos electrónicos que provengan de fuentes de confianza.

Se recomienda utilizar una contraseña segura para acceder electrónicamente a los
programas, p. ej., para el PC, FieldCare, servidor SQL y equipos de campo:
• La contraseña debe contener al menos 8 caracteres
• No utilice un nombre de usuario, su nombre o nombres de empresa
• No debe contener una palabra completa
• Debe ser considerablemente diferente de contraseñas anteriores
• Debe comprender mayúsculas, minúsculas, un número y un símbolo
• Se debe cambiar con regularidad

2.3  Seguridad del producto
DEP: Prevención de ejecución de datos
La DEP es una herramienta de seguridad que ayuda a proteger el equipo contra virus,
daños y amenazas de seguridad. A través de la monitorización de los programas, la DEP
puede ayudarle a proteger el ordenador y garantizar que las aplicaciones utilicen la
memoria del sistema de forma segura. En cuanto una aplicación intenta acceder al
programa, la DEP lo cierra.

Configuración de la DEP
1. Haga clic en Tecla Windows → Tecla Pausa → Configuración avanzada del sistema

→ Avanzada.

2. Introduzca la contraseña de administrador cuando se le solicite.

3. Seleccione Rendimiento → Configuración.

4. Haga clic en la pestaña Prevención de ejecución de datos y a continuación
seleccione Activar DEP para todos los programas y servicios. Si el programa no se
encuentra en la lista, haga clic en Agregar, seleccione el programa y haga clic en
Abrir.

5. Haga clic en Aceptar.
 Se abre el cuadro de diálogo "Propiedades del sistema".
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6. Haga clic en Aceptar.

7. Reinicie el ordenador para activar los cambios.

Número Explicación Estado

0 Siempre desactivada La DEP está desactivada para todos los procesos.

1 Siempre activa La DEP está activada para todos los procesos.

2 Participar La DEP se activa para los principales programas y servicios de Windows;
configuración predeterminada.

3 No participar La DEP está disponible para todos los procesos, aparte de los programas y
servicios.

Mejoras técnicas
Endress+Hauser se reserva el derecho a introducir mejoras técnicas en el software y en los
equipos en cualquier momento sin aviso previo. Dichas mejoras tan solo se documentan si
afectan al funcionamiento del software. Si las mejoras afectan al funcionamiento, se
redacta y se publica una versión nueva del manual de instrucciones.

2.4  Seguridad TI
Nuestra garantía es válida solo si el producto está instalado y se utiliza tal como se describe
en el Manual de instrucciones. El producto está dotado de mecanismos de seguridad que lo
protegen contra modificaciones involuntarias en los parámetros de configuración.

Las medidas de seguridad informática, que proporcionan protección adicional para el
producto y transmisión de datos relacionados, deben implementarlas los operados mismos
conforme a sus estándares de seguridad.
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3  Descripción del producto

3.1  Funciones de software
Este Manual de instrucciones describe cómo puede utilizarse FieldCare para establecer
conexión con equipos HART, PROFIBUS, Foundation Fieldbus, Modbus, IO-Link e
EtherNet/IP utilizando módems, pasarelas de red (gateways) y E/S remotas.

3.1.1  Administración de licencias de software (SLM)
Información detallada sobre la "Administración de licencias de software (SLM)":
Introducción →   6

3.1.2  Roles de usuario
El inicio de sesión de usuarios está desactivado inicialmente tras la instalación de
FieldCare para poder inicializar FieldCare sin iniciar sesión.

Activar el inicio de sesión de usuarios
1. Abra FieldCare Administrator →   14.

2.

Seleccione User and User Groups → Configuration y haga clic en User Login active.

Roles de usuario
Están disponibles diversos roles de usuario. Cada usuario puede iniciar sesión con el rol
específico que se le ha asignado. El usuario recibe autorización para determinadas
funciones. Esto garantiza que solo los usuarios autorizados tengan acceso a las funciones
técnicas y de operación. Además, es posible asignar los derechos durante un periodo
definido.

• Crear cualquier número de usuarios
• Asignar configuraciones opcionales a la cuenta de usuario
• Cambiar la contraseña siguiendo la configuración opcional
• Los usuarios pueden cambiar la contraseña
• La contraseña de usuario es válida durante un periodo específico
• Desactive la cuenta de usuario si fuera necesario
• Asigne el rol de usuario siguiendo el estándar FDT

Rol de usuario Derechos acceso

Administrador Acceso sin restricciones para realizar todas las funciones, p. ej. fases de
desarrollo, puesta en marcha y ejecución en FieldCare.

Tareas administrativas, p. ej. asignar cuentas de usuario.

Cambiar o actualizar el catálogo de DTM.

Ingeniero de planificación Acceso sin restricciones para realizar todas las funciones, p. ej. fases de
desarrollo, puesta en marcha y ejecución en FieldCare.

Ingeniero de
mantenimiento

Llevar a cabo las fases de puesta en marcha y ejecución autorizadas.

Sustituir, calibrar y ajustar los equipos.

Introducir parámetros en los equipos, cambiarlos o leerlos.

Llevar a cabo operaciones específicas de equipo en modo online.
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Rol de usuario Derechos acceso

Usuario Llevar a cabo las fases de puesta en marcha y ejecución autorizadas.

Observar y gestionar el proceso actual.

Comprobar el estado actual de un equipo.

Cambiar los puntos de ajuste para garantizar que el equipo funciona
correctamente.

Observador Observar y gestionar el proceso actual.

Leer parámetros de equipo y documentos de equipos conectados.

3.2  Aplicación
FieldCare es la herramienta universal para configurar y gestionar equipos de campo
inteligentes. Permite configurar el equipo, gestionar su mantenimiento, llevar a cabo el
mantenimiento basándose en su estado y gestionar el ciclo de vida, todo ello de manera
sencilla. Ofrece la posibilidad de adaptarse a diferentes necesidades según la licencia, por
lo que se puede actualizar y mejorar en cualquier momento.
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4  Instalación
Información detallada sobre "Instalación": Primeros pasos →   6
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5  Configuración

5.1  Inicie FieldCare.
‣

Abra FieldCare.
 FieldCare se abre.

5.2  Enlace FieldCare al Portal W@M.
Requisitos para FieldCare y el portal de conexión W@M:
• Es preciso instalar FieldCare/FieldCare Administration y W@M
• W@M instalado normalmente en un servidor
• FieldCare/FieldCare Administration instalado normalmente en un PC
• Termine el contrato del W@M Portal y cree las cuentas de usuario
• Cree el usuario y contraseña en el W@M Portal

5.2.1  Establezca los parámetros de configuración en FieldCare.
1. Inicie FieldCare→   13.

2. Cierre el cuadro de diálogo "FieldCare".
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3. Haga clic en Extras → Options.
 Se abre el cuadro de diálogo "Options".

4. Haga clic en la pestaña "W@M".
 Se muestra la pestaña W@M.

5. Marque la casilla Enabled y seleccione Serial Number (default).
 Los equipos se identifican según el número de serie entre el portal W@M y

FieldCare.

5.2.2  Establezca los parámetros de configuración en FieldCare
Administration.

Cierre FieldCare antes de iniciar FieldCare Administration.
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1.

Abra FieldCare Administration.
 Se abre el cuadro de diálogo "FieldCare Administrator Login".

2. Introduzca Administrator como nombre de usuario y Admin como contraseña y
haga clic en Login.
 Se abre el cuadro de diálogo "FieldCare Admin".
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3. Seleccione W@M Configuration.
 Se abre la vista "W@M Configuration".

4. Seleccione W@M Portal URL y haga clic en Apply.

5. Seleccione el usuario.
 Se abre la vista "User".

6. Haga clic derecho en Administrator → Properties.
 Se abre el cuadro de diálogo "User Properties".
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7. Haga clic en la pestaña W@M.
 Se abre la pestaña "W@M".

8. Introduzca User Name y Password y haga clic en OK.
 Se cierra el cuadro de diálogo "User Properties".

9. Cierre Windows Explorer.
 El administrador establece la conexión con FieldCare.

Funciones W@M
1. Haga clic derecho en un equipo.



2. Haga clic en Device in Web → Show device specific details.
 Se lleva a cabo un test de conectividad con W@M.

3. Haga clic derecho en un equipo.

4. Haga clic en Documentation.
 Se llaman todas las funciones de W@M disponibles.

FieldCare proporciona diversas funciones para la sincronización de datos de FieldCare con
W@M Enterprise:
• Cargar la configuración de parámetros offline a W@M
• Cargar la configuración de parámetros online a W@M
• Comparar las configuraciones de parámetros online y offline
• Comparar la configuración de parámetros offline con su historial
• Comparar la configuración de parámetros online con su historial
• Comparar el historial de configuraciones de parámetros

5.2.3  Integración de la verificación Heartbeat en el Portal W@M
1. Establezca los parámetros de configuración en FieldCare→   13.

2. Establezca los parámetros de configuración en FieldCare Administration→   14.
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3. Seleccione W@M Configuration.
 Se abre el cuadro de diálogo "Conexión".

4. Introduzca el número de contrato W@M y haga clic en Aplicar.

El usuario recibe un número de contrato W@M solicitándolo en el Portal W@M.

5.3  Interfaz de usuario

 1 Cuadro de diálogo principalFieldCare

1 Vista de planta
2 Vista de red
3 Barra de menú
4 Barra de herramientas
5 Vista de DTM/parámetros
6 Cuadros de diálogo opcionales
7 Barra de estado

5.4  Ajustes generales

5.4.1  Configuración de proyecto
1. En FieldCare haga clic en Extras → Options.
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2. Haga clic en la pestaña Project.
 Se abre la pestaña "Project".

3. Seleccione Prompt for project at start-up y haga clic en OK.
 Cada vez que se inicia el programa se abre el cuadro de diálogo de proyecto.

5.4.2  Ajustes de escaneado
1. En FieldCare haga clic en Extras → Options.

2. Haga clic en la pestaña Scanning.
 Se abre la pestaña "Scanning".

3. Marque la casilla junto a Connect after scanning if only one device is found and
automatically open the DTM in the Online window y haga clic en OK.
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Cuando haya ajustado la configuración, se muestra el resultado del escaneado.

Tras el escaneado, si FieldCare solo encuentra un equipo, se establece una conexión
automática con el DTM y se conmuta a online. Cuando encuentra más de un equipo,
se debe conectar cada DTM por separado. En función del DTM, hacer doble clic sobre
un equipo desconectado también iniciará la conexión. En caso contrario, se debe
utilizar la opción Connect. La configuración de equipos concretos no se describe en
este Manual de instrucciones. Esta información se encuentra en el Manual de
instrucciones del equipo en cuestión.

Por defecto, FieldCare utiliza las interfaces FDT 1.2 para realizar un escaneado. Si está
habilitada la opción "Preferible escaneado FDT 1.2.1", se pueden usar como alternativa
las opciones de escaneado FDT 1.2.1.

FDT 1.2.1 ofrece ventajas en cuanto a la velocidad de escaneado con DTM Comm /
pasarela de red (gateway) propias.

5.4.3  Vista de planta
Los cambios en la vista de red se sincronizan automáticamente con la vista de planta.
Los cambios manuales en la vista de planta no afectan a la vista de red. Por lo tanto,
es posible diseñar una planta de forma independiente a la topología de red.

Añadir un nuevo nivel
1. Haga clic derecho sobre un elemento.

2. Haga clic en Plant View → Add Plant Level.
 Se puede seleccionar un nuevo nivel de planta.

 2 Estructura de la vista de planta

Nivel de planta Descripción

Empresa Crear solo una entrada de este tipo en el nivel superior 0.

Sitio
Área
Celda de procesos
Unidad

Crear en nivel 1.

Área
Celda de procesos
Unidad

Crear con el tipo "Site".

Celda de procesos
Unidad

Crear con el tipo "Area".

Unidad Crear con el tipo "Process cell".
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Nivel de planta Descripción

Equipo de análisis
Equipo digital
Presión
Especial
Equipo de caudal
Nivel
Equipo de temperatura
Válvula
Equipo desconocido

Crear con el tipo "Unit".

Elemento Cambie el elemento a continuación con Change software.

 Esto ya no es posible de forma retroactiva para todos los demás tipos. En este
caso, el tipo se debe eliminar y crear uno nuevo.

 Una entrada se puede enlazar lógicamente con un equipo en la vista de red con la función Asignar.
Elimine el enlace utilizando Unassign Device.
A continuación se pueden modificar los textos de título de todas las entradas.
Mediante el menú contextual se puede introducir una nota para cada entrada o se puede enlazar cada
entrada con un archivo o una URL de un sitio web.

La vista de red debe estar creada para poder crear la vista de planta. La vista de planta se
corresponde con la topología de planta real, la vista tecnológica es una representación
jerárquica del proceso de producción. Todos los usuarios con el rol "Planning engineer" o
superior pueden crear nuevas vistas de planta o modificar las existentes.

Los elementos se pueden desplazar en la vista de planta. Los elementos de la vista de
planta se pueden renombrar, añadir o eliminar.

Columna Uso

Etiqueta (tag) de la planta Etiqueta (tag) de planta para cada posición de planta.

Conexiones Símbolo que indica el estado online/offline.

Estado Indica el estado de diagnóstico.

Monitorizado Opción para habilitar la monitorización del equipo mediante Condition Monitoring.

Crítico Opción para especificar si se trata de un equipo esencial.

Canal Indica con qué canal se conecta el equipo.

Dirección Indica la dirección del equipo que se asigna a esta posición de planta.

Tipo de equipo (DTM) Indica de qué tipo de equipo se trata.

Equipo físico Identifica el equipo físico en un punto concreto de la red.

5.4.4  Vista de red
La vista de red es una representación gráfica de la red de equipos que pertenece al proyecto
FieldCare.

Columna Uso

Etiqueta (TAG) de la red Etiqueta (TAG) de red del equipo.

Conexiones Símbolo que indica el estado online/offline.

Canal Indica con qué canal se conecta el equipo.

Dirección Dirección de red única del equipo.

Tipo de equipo (DTM) Indica el tipo de equipo para cada uno de los diferentes equipos.

Equipo físico Identifica el equipo físico en un punto concreto de la red.
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5.5  Funciones generales
Vista de planta/red
• Ajustar utilizando el Menú contextual → Vista de planta personalizada
• Cuadro de diálogo del indicador
• Mostrar/ocultar columnas
• Ajustar el orden de las columnas

Función de lista
• Ajustar para que las listas se ordenen según el título de columna
• Cambiar el ancho de columna
• Cambiar el orden de las columnas utilizando "Copy" y "Paste"

5.6  Comprobación de la red
La topología de red en FieldCare puede compararse con la red física real. Esta opción es
especialmente útil si el equipo se añade a una red existente. Los proyectos se pueden
preparar offline y cargarlos más tarde mediante FieldCare. De esta forma es posible
verificar la topología efectiva de la red y la topología física para realizar cualquier cambio
que sea necesario.

Antes de comprobar la red, tenga en cuenta que solo las redes verificadas se
comprueban para buscar equipos de comunicación que dispongan de al menos un
DTM. De lo contrario, el elemento de menú Verify Network está deshabilitado.

Comprobación de la red
1. En la vista de red, seleccione un equipo con al menos un DTM.

2. Haga clic en Verify network  en la barra de herramientas.
 Se abre el cuadro de diálogo "Communication channel".

3. Seleccione el canal deseado y haga clic en OK.
 FieldCare escanea el canal deseado.

Cuando se haya verificado la red, se abre el cuadro de diálogo "Scanning Result".
Se visualiza la Lista activa y la columna Status indica cómo encajan los equipos de
la topología diseñada anteriormente en la topología real.
Existen cinco estados diferentes en total:
Los tipos de equipo y los números de serie son idénticos.
Los tipos de equipo son idénticos.
Los tipos de equipo son diferentes.
Se ha encontrado un nuevo equipo.
Equipo inesperado en el proyecto.

4. Los cambios se pueden realizar en el menú contextual del equipo en cuestión. Leer/
introducir datos de equipo o remplazar el tipo de equipo.
Haga clic en OK para confirmar los cambios.
 Se han guardado los cambios.
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6  Integración en el sistema

6.1  Configuración de una dirección IP
• Se requieren derechos de administrador
• La descripción es aplicable para Windows 7

Todos los equipos de Endress+Hauser con una interfase Ethernet se suministran con una
dirección IP predeterminada, p. ej. la dirección IP del Fieldgate FXA720 es 192.168.253.1.
Para que el ordenador host pueda comunicarse con el servidor web Fieldgate FXA720, se le
debe asignar una dirección IP en el mismo dominio de la dirección, p. ej. 192.168.253.99.
Para más información, póngase en contacto con su administrador de red.

Configurar la dirección IP del ordenador
1. Haga clic en Inicio → Panel de control → Redes e Internet → Centro de redes y

recursos compartidos.
 Se abre el cuadro de diálogo "Conexiones de red".

2. Haga clic en Administrar conexiones de red.

3. Haga clic derecho en las conexiones que se deben cambiar.

4. En caso necesario:
Introduzca la contraseña de Administrador o confirmación.

5. Haga clic en la pestaña Redes.

6. Haga clic en Protocolo de Internet versión 4 (TCP/IPv4) en la entrada "Esta
conexión usa los siguientes elementos".

7. Haga clic en Propiedades.

8. Apunte los valores originales de la dirección IP y la máscara subred del ordenador
para poder restaurarlos si fuera necesario al final de la operación. Los ordenadores
utilizados en una red de empresa obtendrán su dirección automáticamente.
Haga clic en Utilizar la siguiente dirección IP.

9. Introduzca la dirección IP, la máscara de subred y el gateway predeterminado
para "TCP/IPv4".
 Se acepta la configuración de la dirección IP.

10. Haga clic sobre Aceptar.
 El procedimiento se ha completado.

6.2  Firewall de Windows
Si se utilizan firewalls en los ordenadores que alojan los servidores y clientes, se debe
programar el acceso mutuo. Dado que la configuración del firewall es a menudo una
cuestión de política de seguridad informática de la empresa, debe consultar al
administrador del sistema antes de continuar. Además, se necesitan derechos de
administrador para realizar esta tarea.

Los puertos disponibles para el Fieldgate SFG500 se listan en la tabla siguiente:

Número de puerto ID

TCP 60010 TCP_PCPS2_SFG500_PORT

UDP 60015 UDP_IDENTIFY_PORT

UDP 60020 UDP_ANNUNC_PORT
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Gestión del firewall de Windows
1. Pulse Inicio → Panel de control → Firewall de Windows.

2. En el panel izquierdo, haga clic en Permitir una aplicación o característica a través
de Firewall de Windows.

3. En caso necesario:
Introduzca la contraseña de administrador.

4. Haga clic en la casilla junto al programa que desea permitir y haga clic en Aceptar.

5. En el panel izquierdo, haga clic en Configuración avanzada.

6. En caso necesario:
Introduzca la contraseña de administrador.

7. En el cuadro de diálogo "Firewall de Windows con seguridad avanzada", haga clic en
Reglas de entrada.

8. En el panel izquierdo, haga clic en Nueva regla.

9. Siga las instrucciones del Asistente para nueva regla de entrada.

10. Vaya a la pestaña Excepciones.
 Se abren dos niveles principales. Se pueden añadir excepciones a estos niveles.

"Añadir programa" especifica qué aplicaciones pueden responder a peticiones no
solicitadas.
"Añadir puerto" especifica que el firewall debe permitir el tráfico TCP en los
puertos utilizados por los servidores.

11. En la pestaña "General", marque la casilla Conectado (recomendado).

El firewall está ahora activo.
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7  Configuración
Los datos relacionados con el proyecto se almacenan en una base de datos o en archivos,
en función del modo de almacenamiento del proyecto.

7.1  Establecimiento del idioma de configuración
1. Abra FieldCare.

2. Haga clic en Extras → Options.
 Se abre el cuadro de diálogo "Options".

3. Seleccione el idioma requerido en la pestaña "Display" y haga clic en OK.
 El idioma se guarda y está disponible la próxima vez que se inicia el programa.

7.2  Creación de un proyecto
Los primeros pasos para la creación de un proyecto son siempre idénticos. El cuadro
de diálogo FieldCare aparece de manera predeterminada; se puede desactivar en
Extras → Options → Project. El cuadro de diálogo FieldCare se deja de mostrar si está
marcada la casilla None.
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Creación de un proyecto
1. Abra FieldCare.

 Se abre el cuadro de diálogo "FieldCare".

2. En la pestaña "New", seleccione el elemento Create Project y haga clic en Open.
 FieldCare abre un nuevo proyecto con un PC host.

7.3  Guardar un proyecto
Los proyectos de FieldCare se guardan en una base de datos pero no están accesibles
como archivos en el disco duro. Es posible acceder a estos archivos utilizando
FieldCare en el modo archivo. Todos los proyectos se guardan de la misma forma.

Guardar un proyecto
1. Seleccione File → Save As.

 Se abre el cuadro de diálogo Save Project As.

2. Introduzca un nombre de proyecto y haga clic en Save.
 Se guarda el proyecto.
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7.4  Abrir un proyecto guardado
Abrir un proyecto guardado
1. En el cuadro de diálogo FieldCare, haga clic en la pestaña Existing.

 Se abre el cuadro de diálogo "Open Project". Los últimos proyectos abiertos se
muestran.

2. Seleccione Project y haga clic en Open.
 Se muestra el proyecto.

Si el proyecto no aparece en la pantalla, haga clic en View → Network.

7.5  Exportar e importar CSV
La información estructural de la planta y la vista de red (topología de planta/red) se puede
exportar en un archivo CSV e importar de un archivo CSV a un proyecto de FieldCare.

Importar archivo CSV
1. Crear un proyecto. →   25

2. Haga clic en File → Import/Export → Import CSV file.
 Se abre el cuadro de diálogo "Import CSV file".

3. Seleccione un archivo y haga clic en Open.
 Los datos del archivo CSV se importan en la vista de planta y/o la vista de red.

Exportar archivo CSV
1. Seleccione un proyecto.

2. Haga clic en File → Import/Export → Export CSV file.
 Se abre el cuadro de diálogo "Exported topology".

3. Haga clic en Export.

4. Seleccione una ubicación de almacenamiento y un nombre y haga clic en Save.
 La vista de red se exporta en un archivo CSV.

7.6  Información del DTM
El cuadro de diálogo Information contiene un resumen de toda la información de DTM
relevante.
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Visualizar la información de DTM
1. Haga clic en DTM Catalog en la barra de menú.

2. Haga clic en Display.
 Se abre el catálogo de DTM.

3. Haga clic derecho sobre un DTM.

4. Haga clic en DTM Information.
 Se abre el cuadro de diálogo "Information".

Opciones posibles en el cuadro de diálogo "Information"
• Muestra información básica de todos los DTM de tipos de equipo compatibles
• Muestra información de DTM:

• ID de fabricante
• Device Type ID
• ID de tipo de subequipo
• Información del tipo de equipo

7.7  Visualizar el catálogo de DTM
El cuadro de diálogo "DTM Catalog" contiene la lista de todos los DTM que se encuentran
actualmente en el sistema de gestión de equipos. Los DTM se pueden agrupar por
categoría, fabricante o protocolo.

1. Haga clic en DTM Catalog en la barra de menú.

2. Haga clic en Display.
 Se abre el catálogo de DTM.

7.8  Actualizar el catálogo de DTM
Información detallada sobre "Actualizar el catálogo de DTM": Primeros pasos →   6
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8  Diagnósticos y resolución de fallos

8.1  Localización y resolución de fallos generales

Fallos Localización y resolución de fallos

No se inicia el Servidor
SQL de FieldCare.

Iniciar el Servidor SQL manualmente:
• Inicie Windows e introduzca services.msc en el campo de búsqueda.
• Seleccione Servidor SQL (SQLFIELDCARE).
• Haga clic en Inicio.

Escanee las macros que
faltan.

Importar macros:
• En la carpeta "...\Endress+Hauser\FieldCare\db" importe el archivo

ImportScanningMacros.cmd.
• A continuación reinicie FieldCare.

Duplique las entradas de
menú o ventanas que
faltan.

Restaure la distribución
• Cierre FieldCare.
• En la carpeta "...\Endress+Hauser\FieldCare\Profiles", elimine el archivo

profile.xml.

Errores en el catálogo de
DTM.

Reiniciar el catálogo de DTM de FieldCare:
• Cierre FieldCare.
• En la carpeta "...\Endress+Hauser\FieldCare\Frame", elimine el archivo

FRMRepository.xml.
• Reinicie FieldCare y actualice el catálogo de DTM.

Si se produjeran otros fallos o averías, póngase en contacto con su centro Endress
+Hauser: www.addresses.endress.com
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9  Actualizaciones del software
Información detallada sobre "Actualizar el software": Primeros pasos →   6
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